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1. Advanced searching

Select search then advanced

@® RefWork

| Mewy Folder 5 Cre eference
/ E By Authior _—
By Descriptor
References = All Refe
By Periodical
References '-.-ai]i:lnline Catalog or Database Folders
Referenceﬂo!"-:d Sort by
@ selected | (O Page T o0 Feeds I = = Authors, Frimary t]

Construct your search terms using Boolean terms and choose where to search (author, title, attachment etc.):

ur Database

Saved Search | [Mew Search] M
Search far Emp
ch Field: | Amawhere M far | kenya Ll
Search Field: | Anywhere M for  |nigeria] O]
References to Search 5| References W

You can save your search for easy reference to next time or just hit search

= save 4, Search | 2 Reset
A

‘ &) Print References
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Search using lookups

. 1. FromtheRefWorks toolbar, select Search >
Task 2: Using Lookups

By Descriptor
Lookup by Desecriptor 2. Locate any descriptor that has more than
onerecord

Search Your Database

: - - R ) _ 3. Click onthe descriptor to display all the
AECDEFGHIJELMNOPRRSTUYWHYZ

recordswith that term inthe descriptor

[Ftherapeutic use]| - [Adrenergic betz-Antagonistsiadminisiration £ field.
docagaiherapautic use]

O egeiigla Hismber af Reteiances | Edil [Dalels

Motes:
“Therapeulic usal 1 L. x Aciiilie . .
--------------------------------------------------------- You canedit ' or delete % a specific
[5ups11<5up=CIEIPII1195 1 ERE Agabat _
- lookupterm {authar, descriptar ar

Dt - ptyeregl-1,2.2,8 —— ar Ardeticy
tetrahydrapyndine i e periodical} from the iconsnext ta 3
et et darival - i i
T e SE 7 N gl descriptor. These options only edit or
L osans Adening e .
B Horivain deletethe specific value, nat the ertire

Il it 4-phargl1,2 3.8 Htherapd
intrahviropwridine/amerse 3 LR reference.
e Arlann.
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2. Using my list

My List is a temporary folder when you log out of RefWorks, this temporary folder will be cleared. It can be
useful for staff to use during workshops as my list is deleted after the workshop so your RefWorks account will
be the same.

o
To add references to my list simply click the star icon next to any references you want to add, you can add
as many as you need

Feferences = All References

References | Organize & Share Folders 123 Next Last
References to Use Sort by Change YWiew
@seteated | Orage § Ominti i | ° @ X8 [Authors, Primary v  Standard View [v]
i ReflD 1434 Generic Reference 1 of 54 A b4 A @
Title, Primmary  Microsoft's Protocol Documentation Program: Interoperahbility Testing at Scale

Source Commun ACH, 2011, 54, 7, 81-57, Association for Computing Machinery

i ] ReflD 1431 CasefCourt Decizions Reference 2 of 54 AE ¥ 9,

Title Mansfield and Another s Weetahix Ltd and Another
Source Official Transcripts (T990-19597, 1897, COURT OF APPEAL (CIMIL DIVISION)
Folders Emma;

Then from the folder list just choose my list to work with the references you selected earlier. Remember My
List is deleted every time you log out of RefWorks but the references will still be store under all references and
in any folders you have added them to.

References | COrganize & Share rs
References to Use Sort by
@selected | OPage | Oaninuis @ |0 7 (@)X Authors, Primary
Eg Mew Fald [ﬁ]_
[ RefiD 1434
I by List
Title, Primary  Microsoft's Protocol Doy a5t
Source Commun ACH, 2011, 54 Cell biology (1) dar
N RefID 1431 childhood (3 =54

Title Mansfield and Another v’ biz=s i)
Source Official Transcripts (8980 pocuments @ L
Folders Emma;

Emma ()
| N Rafil 1444
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3. Adding attachments

To attach a file to you RefWorks record:
Save the file that you want to attach.

Locate the appropriate RefWorks record and go into the edit page

References | Organize & Share Folders |
References to Use Sart by

@selected | OPage | Qanimus | |0 7 &% = Authors, Prirmary |v|

12 3 Mext Last
Change Wiem

S e M

i[] ReflD 1434 Genetic Reference 1 07 54

Title, Primary  Microsoft's Protocol Documentation Program: Interoperability Testing at Scale
Source Commun ACH, 2011, 84, 7, 81-47, Association for Computing Machinery

Scroll to the attachment option and browse to the file on your computer you wish to save

o ' - 1

Add to folder Select 3 foldet.. v

Attachments Mo file selected.

b Additional Fields

Once the file has been added, click save

Altachments Mafile selected.

Delete

2

LS013 Guide to Finding Information.pdf
(214 k)

" Additional Fields

© Mext [ Duplicate || [=] Save Reference

Any reference with an attachment has a paper clip icon

i ] ReflD 1413 Journal Aticle Reference 5 of 54 & A 4 g

Authors  Akbarian |s'haad
Title The relationship hetween vacabulary size and depth for ESF/EAP learners

You can also search_any pdf attachments you have added using the advanced search technique (See 1.
advanced searching)
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4. Importing references using B 5% feeds

Go to Nature magazine’s RSS feed page at http://www.nature.com/nature/newsfeeds.html or choose your
own RSS feed

Right-click on the Nature's current issue table of contents link and select copy link location

WEB FEEDS

MNature provides its latest tabhle of contents as an RS55 web feed, so an ge
science delivered straight to your desktop.

Receive Mature's current issue table of contents.

Receive Mature's Latest Research.

RHeceive MNature's Biological Sciences Hesearch

Cpen Link in Mew Tab
Receive Mature's Chemical Sciences Resea Open Link in New Window

. . . Cpen Link in Mew Private 'Win
Feceive Mature's Earth and Environmental =

Bookmark This Link.
Save Link As...
Copy Link Location

Receive Mature's Physical Sciences Hesear

Receive Mature's Mews & Comment.

g Save Link with DownThemall!
g Skart sawing Link with dTa OneClick!

Feceive Mature's Comment aricles.

Receive Mature's Latest Free Content.
Inspeck Element {2

There is also an RSS feed of A0F Mature an

Refarab-Ik

Receive Mature's ADP table of contents.
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http://www.nature.com/nature/newsfeeds.html

Back in RefWorks click search and then RSS feeds

® RefWorks

“sAdvanced

| Mewy Folder Cre
! E By Authior

efe

By Diescriptor
References = All Refe

By Periodical

References '@Online Catalog or D3

Referances ta .
{E}SHEGtEd {:}F‘age RS5 Feeds

Simply paste the URL into the feed box and click add RSS feed

RSS Feeds in your account © Help

&) http: /weh ebscohost com/ehostiresults ?sid=49100522-721d-4073-8c53-03e6368e2547 %40sessionmgra003&yid:
bdata=trmRIFANpECAkY 1T hOW OGS 1 LT Ry 2k GEEWIE I RIPYWWF zd S A 1 Id G GlAenpo. mBiIPYMNwa
o3 % Sk

o XK
B BEC Sport - Olympics oK
Eﬁ BBEC Sport - Sport Editors'blog
This blog is where our editars write about our coverage and issues. Here are adr tips and house rules. [fyou have a general
gquestion check our FAZS ar our hroadeast schedule, Ifyou can't find an answer, e-mail us.

o K

BY BBC Sport - Tim vickery blog
| caver South American football from Brazil. There's 3 wealth oftalent and a rich culture - 3 fascinating continent ta fallow faathall.

Here are some tips on taking part and our house rules.
> R

| hitp:/ffeeds nature. com/MNatureFhysicalSciencesResearch Add R5S Feed
— 4
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RefWorks will now retrieve the RSS feed, however it gives the option of checking the feed before importing

everything. Simply tick the boxes of any item(s) you want and click import then ok to confirm

Ref ID

Title
Source

RefID

Title
Source

RefID

Title
Source

Ref ID

Title
Source

1 Journal Aicle Reference 1 of 8 5,

Change in the chemical composition of infalling gas forming a disk around a protostar

Mature Physical Sciences Research, =prismirightsAgent xmins:prism="hitp:lprismstandard ori
mamespacesiasic? 0M=permissions@nature com=fprismrightsAgent= =items= =rdf.Seg= =rdfli
rdf.resource="hitprrdx. doi.org/1 0.1 038 mature 3000" /= <rdfli rdfresource="hitpdx dai.orgTEUNCATED)

2 Journal Adicle Reference 2 of 8 5,
Mature Physic ard.ori .
MEMESDACES)  are you sure you wantto importthe 2 selected references? &g <rdrli
rdfresaurce=" rafiTRUNCATED
3 2
Plazma physi
Mature Physic ard.org
Inarnespaces e =rfli
rdfresource=" rofTRUNCATED)
OK Cancel
4 — T— -4

Condensed-matter physics: History matters for a stirred superfluid

Mature Physical Sciences Research, =prismirightsAgent smins:prism="hitp.iprismstandard org
mamespacesfhasic/2 0M=permissions@nature com=fprismrightsAgent= =items= =rdf:Seqg= =rdfli

rdfresource="httpJfdx doiorgM 0.1 038 nature1 3000" f= =rdfli rdfresource="httpdx doi.orgfTRUNCATED)

[s]

= Backto feeds U Import
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5. Deleting duplicates

In RefWorks select View > Duplicates > Exact Duplicates

® RefWorks

ST

s Saved Search Results

g Mew Folder | & Heference
- Al References / /

My List
References =

Duplicates

REfere{kIZileIeted References

Close Duplicates
Referances o use E

.:@ 5

(&) Selected | (D Page © () Allin List "-@ v

[E]‘ Authars, Prire

RefWorks will compare the Author, Title and Publication Year fields for all records in your database and
present exact matches to you

By default RefWorks will mark the most recently added references in a set of duplicates for deletion
Make sure to look through the entire page before proceeding!
Click the delete icon to remove the selected records from your account

Feferences » Exact Duplicates

References | Jrganize & Share Folders
References to Use Sort by Change Vie
I- -] . -
@ selected © (OPage @ Oalintist i | @ 7 & Xa Duplicate M Standard View M
RefID 1445 Book, Whole Reference 1 of ¥ 5[] ¥ 2 B
Authors  Dunne Ma’ire”ad; KairYWambui; Myanjam, Eric
Book Title  Kenya
Source 2008, Wayland, London
|| RefID 1438 Book, Whole Reference 2 of 7 AR, ¢ 8, [

Authors  Dunne Ma'ire’ad; kairiWambui; Myanjorm, Eric
Book Title Kenya
Source 2003, Wayland, London

If there are more than two duplicates, RefWorks will mark only one reference for deletion. You will need to
select others yourself.

6. Sharing references
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There are various ways of sharing references using RefWorks:
Creating a shared account.

If you are working in a research group or university team where you all wish to contribute to a shared
database of references you can create a new RefWorks account using your university team email (e.g.
skills@wlv.ac.uk) or create a personal account and share the username/password among yourselves.

Personal accounts

If you want to share all your references: Click on the Organize & Share Folders tab:

References = All References

References | Organize & Share Folders
“rou hawve 40 referenceis) not in folders. Duplicates not in folders. EHEI Statistics .E‘ Lefault Settings
Share Entire Database {54 7=

Botin Folder {40%

L@ Lastimported 1) E
Cell biology (1} =5
childhood §3) Ea |
Diss (2 =

You will see a list of your folders and an option to Share Entire Database.

To share your all your references - Click on the folder with the green arrow icon opposite the Share Entire
Database option.

Click save, after adding or amending any options.

10
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Shared Folder | [Entire Database] M

@ Hep

The data you are about to share may be copyright protected or subject to data provider restrictions. Users should check with the appropriate
datahase provider{s) to ensure compliance with any restrictions such provider(s) may impose upon downloading ar sharing of the infarmation.

¥ Share Information

URL  hito:fwwwe refworks. comjrefshare27site=066181294635600000/79501

Flw]+]

Title
Title as itwill appearin RefShare

Information

¥ Share Options
* Limitations
¥ Dutput Style Options

* Fields to share

[=] save 5 Reset Copy to default Cancel
RefWorks will generate the URL, so just click the folder and choose email this share:
REfErences | | Organize & Share Folders | Wegars
. S
“rou hawe 40 referencels) not in folders. Duplicates not in folders. EHEI Statistics ,E Cefault Settings
Folders
Share Ertire Database  (54) [ £]¥]

Mot In Folder {40%
U@ LastImported {13 = g
Cell bialagy {13 55 I

Lz | hittp: A v refwork s o
[ Remove Share

j Shared Folder Optior

4] Email this share
d

fsharez

Share A Folder

Follow the steps above but rather than choosing entire database only select a folder.

11
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7. Editing the output style

The majority of users will never need to edit a style provided in RefWorks. RefWorks supports the main
University referencing styles and also includes styles for thousands of publishers of books and journals.

From the create a bibliography choose manage output styles and search for the style you require.

Create a bibliography from a list of re

References to Include From All References: O gelected (o) O Page (251 @ allin List (54)
Yiou can select 3 different folder from the folder area ta the right of this wincosw,

Select an Output Style | APA Bth - American Psychological Association Bth [v| 4 Preview

Select a File Type | HTML v

Meed Help creating & bibliogragphy? Did you weant to format 8 paper and bibliography instead of cresting & bibliogragphy from
a lizt of references?

3 Manage Output Styles E Create Bibliography

P

If you feel you need to edit a style please contact the liaison team at LISLiaison@wlv.ac.uk.

If you feel you are an advanced RefWorks user and wish to attempt to edit a style, RefWorks have guidance
available here: http://www.refworks.com/refworks2/help/RefWorks2.htm.

If using the editing feature the main point to bear in mind is that it is generally much easier to edit an existing
style than to create a new one from scratch, however remember to edit the name when saving so the original
style is intact.

12
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8. Working offline

Using Write-N-Cite 4 Offline:

4 style:| OSCOLA-.. = [@8 SyncMy Database & Log out

@) Bibliography Options - s FRemove Field Codes '@' Preferences

Insert
Citation = ﬂ Reapply Cutput Style &y Open RefWorks Enable Autosync Folder

Citation and Bibliography Extras Settings

Write-N-Cite 4 works the same whether you are online or offline. There is no difference in functionality except
you will lack the ability to sync Write-N-Cite or open RefWorks with your RefWorks account when you are
offline.

Using Write-N-Cite 3 offline:

As all University computers should always be connected to the internet this shouldn’t be an issue as if a
member of staff or a student are using RefWorks offline on a personal computer they will have the latest
version (see above).

The following stepos need to be followed to uise written-cite 3 offline:
Using Write-N-Cite Il for Windows Offline:

Write-N-Cite Ill has a feature that allows you to download your references to a computer and access those
references to use while writing your paper. In addition to being able to view the references and insert
temporary citation placeholders, Write-N-Cite Il allows you to format a bibliography in the style of your choice
while being offline.

Write-N-Cite Ill offline functions the same as if you were online. Regardless of whether you are online or not,
you cannot add, edit or delete references in your account. You need to log in to your RefWorks database to
perform those functions.

Downloading Your RefWorks Account To Work Offline:

1. Launch Write-N-Cite lll and log in. You must be online in order to download your RefWorks
database. Once the data is downloaded you can then user Write-N-Cite Il offline.

2. From the Write-N-Cite Ill Tools menu, select Create/Update Offline Database.
3. Click the Create button.
4. Your data is downloaded.

e Note: Each time you update your RefWorks account and you want to work offline, you will need to
repeat steps 1 through 4 above to update the references stored on your local computer.

5. Click the Work Offline checkbox to work offline.

13
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9. One line/cite view

Use this feature when Write & Cite is incompatible with your word processing software (e.g. Pages or Google

Docs). Note - you should also save your finished document as an RTF (Rich Text Format) file in order for

RefWorks to format the bibliography.

Open your document and log into your online RefWorks account (not your Write-N-Cite account). On the main

page, locate the reference you wish to cite and click cite:

il ReflD 1434 Genetic Reference 1 of 54

Title, Primary  WMicrosoft's Protocol Documentation Program: Interoperahility Testing at Scale
Source Commuan ACh, 2011, 54, 7, 51-57, Azsociation for Computing Machinery

A Citation Viewer window will appear containing the citation:

Citation

141439 Arnold,Helen 1996;%:}

Select the citation. After vou select the citation you
rmust copy & paste itinto your document.

Bibliagraphy Clear Select

Copy and paste or drag and drop the citation into the right place in your document.
Remember to clear the Citation Viewer window before creating your next citation.

In your document paste the temporary citation into the place you want it:

This is my assignment {{1439 Arnold,Helen 1996;}}

After adding all your citations remember to save and close your document.

In RefWorks select bibliography and format document

|
Bihlingrapty

E’Create Bibliography
_g Mew Folder E Create Bibliogra

“F0utput Style Manager
References > All References |

& Output Style Editor
References “_chreviewOutputStyle E

References to Uze T T T T

14
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Select an output style and upload your document and click open:

Select an Cutput Style | ARPA Bth - American Peychological Association, Gth [V] L Praview

RefWorks will then format your document:

This is my assignment {Arnold, 1996)

References

Arnaold, H. [1936). Postcards from Kenyo. London: Penguin.

15
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10. Export your references to a different reference management
programme

Choose references and then export

E Create Bibliography

Jl wport
e et = All References

In the export references box chose which folder (or all references) you wish to export, choose the name of the
reference management programme you wish to export to and click export references.

Export Re

References to Include From All References: O selected (0) O Page (25) © Allin List (54)
Yiou can select a different falder from the folder ares to the right of this windos.

Select an Export Format | Bibliographic Sofware (EndMote, Reference bManager ProCite) M

Meed Help exporting references?

Il Exzport References

Save the file then upload it to your chosen reference management system following their instructions.
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11. Backing Up and Restoring Your Account

RefWorks makes sure your data is safe and secure on their servers, but there may be a time when you wish to
have your own personal copy of your database or you want to move an account to another organisational
subscription. The Backup &Restore feature allows you to create a file that is a copy of your account that can
only be restored in RefWorks.

Backup

Select Tools > Backup & Restore

® RefWorks

Tools

Write-r-Cite

o Mew Folder E Create Bibliography ) Mew R
. . Refizrab-It

References = All References

By default all backup options are selected.

Click the Perform Backup button

You will be prompted to save a .rwb or .zip file to your computer, store it in an easy to access location (my
documents for example).

* Backup

Backup Options: ¥ Include References
M include Atachments
M include RS Feeds
Select Output Styles to Backup Selecill UnseleciAll
Cnpy ofWifater Research

Copy of Walverharmpton Hareard Phil

* Restore

Perform Backup

17
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Restore
Select Tools > Backup & Restore

Click the Restore link and click on browse to select the .rwb or .zip file to be restored

Select the options, you wish to restore and click Perform Restore

B Help
* Backup
¥ Restore
Restore Options: include References
Include Attachments
Cinciude RSS Feeds
include Qutput Styles
Restore Snurce: Mo file selected.
Perform Restore
Notes:

Restoring a database overwrites everything in your account.

If you restore a file from another user, for example to import an output style, please only check the Include
Output Styles

18
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12. RefMobile

You can also use RefWorks to add references or manage your folders on the go. Simply log-in to your
RefWorks account on your smart device (IPad, smart phone etc.) and RefWorks Mobile will launch. You
can search your database, manage folders or add references using author, title or isbn/issn number:

Search View & manage folders

Exclusivel Smart Add View all records

Add a Note

Any changes you make will then automatically sync with your account next time you log-in on a pc.

©0Ce
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